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Beta 2 - August 2020
STRICTLY CONFIDENTIAL!

About this Document / Release Notes

This document contains the alpha release documentation for Cubase 11. It provides you with an overview about the
changes, new features and how to use them.

Over the course of development this document will be updated and extended.
The alpha version of the program (and this accompanying documentation) is work in progress. We consider it 
safe to evaluate and to play around. However, in no case use this version in production environments!
Try out the new features and send us your feedback, we are happy to receive it.
Features are work in progress. GUI elements are not final or may be plain broken. Functions may be 
removed, renamed or changed over the course of development.
Make sure you have back-ups of the projects you intend to use for checking in these versions! Never try 
working with your original real world projects in Alpha versions.
Projects saved with Alpha versions may no longer be opened by older Cubase versions, likewise you may 
not be able to open them in subsequent Alpha versions.

Changes in Alpha 1

Initial Alpha 1 release and documentation

Changes in Alpha 2

Added section "Re-organised Lanes management menus" in chapter "MIDI Editor Extensions"
Added section "Select Steps or Ramps as default curve type" in chapter "MIDI Editor Extensions"
Added section "Delete Notes with double-click / how to access the Note Expression Editor" in chapter "MIDI 
Editor Extensions"
Added section "Combined Select Tool mode: Range-selected events after "Split" selects them as Objects" in 
chapter "Various Other Improvements"
Added chapter "Supervision Metering Plug-in"
Added chapter "Multiband Squasher Plug-in"
Added chapter "Frequency - Dynamic EQ Mode"

Changes in Alpha 3
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Added chapter "Scale-based MIDI Editing in Key Editor"
Added chapter "Global Tracks in Editors"
Updated chapter "Audio Mixdown Enhancements" with various new details and improvements
Added chapter "Sampler Track v2"
Added chapter "Multiband Imager Plug-in"
Updated chapter "Multiband Squasher Plug-in": "Amount" parameters are split into Low and Hi for each band
Updated chapter "Frequency - Dynamic EQ Mode": View mode and Mode switch für Dynamic EQ operation 
added
Added "PolyPressure Lane Handling Improvements" in chapter "Various Other Improvements"
Splitted "MIDI Editor Extensions" topic into separate ones (MIDI CC Curves, Pitchbend Editing Improvements)
Moved "Delete Notes with double-click" to chapter "Various Other Improvements"
Added section Various "Audio Export in WMA format removed" in chapter "  Other Improvements"

Changes in Alpha 4

Updated section "About focus handling and indication" in chapter "Global Track in Editors"
Added section "Focus Indication when using Divided Track List" in chapter "Various Other Improvements"
Updated section "Miscellaneous / Sampler Track v2" with "Fingered Option, Extended Pitchbend Range, 
Sample Quality Settings, REX file support"
Added section "Cut/Copy/Paste Controller Events Improvements" in chapter "Ramps and Curves for MIDI 
CCs"
Updated chapter "Scale-based MIDI Editing", added section "Map MIDI Thru"
Updated chapter "Squasher": GUI is updated, there are now dedicated Up/Down Ratios and Up/Down 
Threshold controls and a new Compressor Characteristics display
Added chapter "Side-Chain with support for multiple Inputs"
Added section "Test Generator, Mixer Delay plug-in Update" in chapter "Various Other Improvements
Added section "Audio Connections - Removed automatic Input/Output presets" in chapter "Various Other 
Improvements"
Added section "Default setting for New Projects location changed to "Prompt for Project Location" in chapter 
"Various Other Improvements"

Changes in Beta 1

Added chapter "Revised ARA 2.0 Support"
Added section "Options for showing Marker Events" in chapter "Various Other Improvements"
Added section "Wave64 Format removed" in chapter "Various Other Improvements"
Added section "Default Track Heights" in chapter "Global Tracks in Editors"
Updated section "Manage Scales..." to "Set up Scales..." in chapter "Scale Assisant & MIDI Editing", various 
corrections
Added section "New Detail View for Maximizer Module in Channel Strip - Channel settings Window" in 
chapter "Various Other Improvements"
Moved information about removed features into separate chapter "Discontinued Features"

Changes in Beta 2

Added chapter "Pitch Visibility in Key Editor"
Added chapter "macOS: Modernized Graphic Back-end"
Updated section "Delete Notes with double-click / how to access the Note Expression Editor" in chapter 
"Various Other Improvements"
Updated chapter "Audio Mixdown Enhancements"
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Audio Mixdown Enhancements

Export Job Queue

Exporting audio files from a project can be a tedious and time-consuming task, especially if different ranges, portions 
or single tracks of a project are needed as independent  For instance, exporting stems or cues. The amount artefacts. 
of time for this process could be easily increased, if the material is needed in different file formats, e.g. for multiple 
distribution channels (AAC for iTunes and wav for DDP) or other purposes. A simple example: the project must be 
exported as PCM and MP3 in one go.

With Cubase 11 we introduce a feature which we call an "export job". An export job can be part of several other 
export jobs all collected in a job queue list. A Job list can contain up to 20 jobs in total. A Job consist of everything 
that can be configured in the audio export dialog:

Channel Selection
Cycle Markers (saved as reference e.g. 1st cycle marker) or locator positions (saved as times)
File Format Settings
File Name
Export Path
Export Options

There are some special decisions:

The settings how to treat naming conflicts (if e.g. files already exist) is not saved. Instead, the jobqueue will 
always create unique file names.
All "After Export" options like "Create New Project", "Send to Wavelab" etc. are not saved as a job and are 
ignored in case of job queue execution.
For the naming scheme, the name of the current scheme is saved as a reference, not the exact settings.

How to create a job

Open the "Export Queue" list
set your export settings for a specific job, set a naming scheme (if wanted) and  click on "Add to Queue"
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Add as many jobs as you need.
If done, start the job export by using the dedicated "Start Queue Export" control

Sub Jobs display for Channel Batch Job

A Channel Batch Job which includes multiple channels in one Job is now displayed  in an expandable/collapsable 
folder view

This allows you:

To have an overview, of the resulting  audio files and their final names  after the export process.
To see directly, which and how many audio files will be generated when applying the "Start Queue Export" 
button.

Remove Job(s)

You can remove all jobs from the queue list by using the "Remove all from Queue" control on top of the "Export 
Queue" list. It is also possible to remove single jobs from the list. Therefore, each job has its dedicated bin control at 
the end of the job row. Click on the bin control and the job will be removed from the list. 

Update Job settings in Export Job Queue

If you select an existing Job in the Export Job Queue, all the settings for this job are reflected immediately in the 
Audio Export Dialog. That means, all settings in the Audio Export dialog will be updated corresponding to the selected 
Job. Additionally, the update control turns orange to indicate that the job has been changed and can be updated by 
clicking the control. If you want to update an existing Job in the Export Job Queue (for instance, adding another 
channel to a channel batch export), simply select the job, update the needed settings and click the update button left 
beside the button with the trash icon - done.

Save Job Queue

A created Job Queue is part of the Project and will be saved with it
If the job queue is changed, you will be asked to save the project when you want to closes
A job queue is always project related: This means that in the export audio dialog, only the job queue of the 
currently active project is visible

Job validation 

We implemented a job validation system, which checks several pre-conditions if a job is valid or not. Jobs are valid if:

At least one channel is selected
For cycle marker mode
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at least one cycle marker is selected
For locator mode

The locator range is not empty
The current naming scheme will not produce any name conflicts
The selected export path exists

The validity is checked before doing the audio export (in case of the current setup) or before the job is added to the 
job queue. If the job is not valid, an error information is displayed and the job is rejected / the configuration not 
executed.

Please note: When executing the jobs in the job queue the validity is not checked again, although e.g. the 
markers might have been deleted in the meantime. 

Apply "Start Queue Export"

If you have setup your Job list, you can start the export process by simply clicking the "Start Queue Export" control. Th
e progress for each Job will be displayed directly in the Export.

Export Progress:

When starting/running the export process, your can see the status of the progress directly in the job queue 
view.
Progress States: no progress / waiting / running / completed
During processing the audio export dialog will become modal (no interaction within the application is possible)
Abort Function

Effects and EQ Options

For Cubase 11, we added Effects and EQs options for the Audio Export Mixdown similar to the signal path options 
in  Render In Place. Each export job can has its own Effects and EQ options. Available options are:

Default - "No selection" - All insert effects, EQ and other channel settings are taken into account.
the channel width is taken "post panner", i.e. a mono channel routed to a stereo group is exported as 
stereo
this setting is called STANDARD, because it is the same as in the C10.5 without any signal path 
option

Disabled (Dry) - insert effects, EQ settings etc are bypassed
the channel width is taken "pre panner", i.e. a mono channel routed to a stereo group is exported as 
mono

+ Groups/Sends (CSP) - also any effects and settings on all channels (e.g. group channels and fx channels) 
towards the output channel are taken into account.

The insert FX and EQ settings of the master channel are ignored. 
the channel width is taken "post panner" (of the output channel).

+ Master/Groups/Sends (CSPM)
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same as above, but also the insert FX and eq settings of the output channels are taken into account.

File Format Presets 

In Cubase 11 it is now possible to create file format presets from your favorite or most used file format settings.

A file format preset includes:

File Type
Sample Rate 
Bit Depth 
Audio Chunk settings

To create a preset simply make your file format settings, click on the "Preset" combo box and select "Save Preset". 
Give a name and the preset is globally stored and can be used for any project. 

Settings are stored in the Presets folder:

Windows: "C:\Users\<username>\AppData\Roaming\Steinberg\Cubase 
11_64\Presets\AudioFileFormatPreset"
macOS: "/Users/<username>/Library/Preferences/Cubase 11/Presets/AudioFileFormatPreset"
The File Format Presets are also part of the user Profile Manager.
It is also possible to "Rename" and "Remove" existing presets.

Revised channel overview/selection list

The channel selector list has also been revised for Cubase 11. The list follows now the same look and feel like the 
channel/track list in the "Import Tracks from Project" dialog. The channel selector includes the following information:

channel color
channel icon
channel width

New Selection option: You can now also select multiple channels by click (in the selection box), hold and drag the 
mouse down.

Selection Functionality as before:

Single and Multi Mode (incl. persistency)
Expand and collapse channel type folders
Channel type folder selection (only in Multi Mode)
Filter channels by text entry
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Sync Channel Selection List with Channel/Track selection in Project Window

For the Multi Channel Export option in the Audio Export Dialog, we added a new function "Sync Selection to Channel
/Track Selection". This mode becomes available, if Multiple Export is selected.

If you activate this mode, the channel list in the Audio Export dialog will follow dynamically the Track/Channel 
selection from the Track list in the Project Window. So the list will be filtered and shows only the Tracks/Channels 
selected in the project Track List. The same is valid for channel selections you apply in the MIxConsole. This allows 
you, to fill up the channel selection list in the Audio Export dialog by the selected Tracks/Channels in Project. This is 
especially useful for ad hoc export tasks or for creating stems. This in combination with the new signal path options 
and the Job Queue export provides you a very powerful and time saving workflow.

This works for the following Channel/Track Types:

Audio
Instrument
Group
Effects
Return/Synth Channels
Rewire

Hint: A selected MIDI Track, which is connected to a VST Instrument, will not select its corresponding Return/Synth 
channel. So if you want to use this feature in combination with VSTi MIDI Tracks, make sure, to select the Return
/Synth Channel instead of the MIDI Track in the Project Track List 
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Dedicated, new default Mixdown Folder in the Project Root Directory 

With Cubase 11, we introduce a new, dedicated Mixdown folder in the project root directory, besides the Audio 
project folder 

This Mixdwon folder is for each new created project pre-defined in the File Location Path as a default path for any 
Audio Export Mixdown. Of course, the path could be changed at any time and the new path will also be stored with 
the projec7 (see also New Dialog Persistency)

Specification

below the existing option to use the project's audio folder a   provides a default   to new menu entry shortcut
the project's mixdown folder "Project Mixdown Folder"
The project mixdown folder is located in the project directory as root folder and called "Mixdown"
selecting the menu entry will create the mixdown folder and change the export path to this folder

since it is only a   the menu entry will not be checked afterwardsshortcut
if " " is enabled it will be   when then project mixdown folder is selecteduse project audio folder switched off
exporting to the mixdown folder will not lead to the mixdown folder being added to the recent path list
if a   is created, or a project loaded or created from a template, where no export path new empty project
information is available, the project mixdown folder is set as default
There are no restrictions as to "Create new project" (in comparison to use project audio folder) 
"Backup Project" will not copy any contents of the mixdown folder to the backup location (TBD)
if a job has the mixdown folder as export path, it will be shown as "Project Mixdown Folder" in the job queue

Audio Export Dialog Settings - New Dialog Persistency

For Cubase 11 we changed the persistency of the Audio Export Mixdown Dialog settings. In former versions, most of 
the settings have been stored globally. For instance, the file name, the file path etc. . Now the filename will be 
generated from the project name by default. The file path is set to project Mixdown folder by default. Changes will be 
stored/saved with the project.

A lot of these settings are now stored/saved with the project. Here an overview of the persistency for all available 
dialog settings: 

Area Stored Globally  Stored in Project Initial State (create new Project)

Channel Selection 

Single/Multiple switch x Single

Collapse/Expand list state x Expanded

Sync Channel selection switch state x Off

Effects and EQ

Selected Option x Default
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Export Range 

Locators/Cycle Markers switch x Locators

Export Queue

Show/Hide state x x Hidden 

Collapse/Expand list state x Expanded

Job List x

File Location

File Name x Project Name 

File Path x Use Project Audio Folder

Naming Scheme x x

File Conflicts  Selected Option x Always Ask

Recent File Paths x List is empty

File Formats

File Type  x x Wave

Sample Rate x x Adopted from Project Setup

Bit Depth x x Adopted from Project Setup

Insert iXML chunck x x On

Insert Tempo definition x x Off

Don't Use Wave Extensible Format x x Off

Don't uUse RF64 Compliant Format x x Off

Insert Broadcast Wave Chunk x x On

Settings(Info For BW Chunk x x Cubase

Channel Modes 

Mono Downmix x Off

L/R Channels x Off

Split Channels and Setting x Off

After Export 

Create New Project x Off

Create Audio Track x Off

Insert to Pool x Off

Post Process selected Option x None

Pool Folder Name  x Empty

Export Options 

Realtime Export x Off

Deactivate External MIDI Inputs x On

Update Display x Off
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Keep Dialog Open  x
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Ramps and Curves for MIDI CCs
With Cubase 9.5 we introduced the possibility to use curves for automation data in the Project window. This has been 
extended for continuous MIDI CC data in the Controller Lanes of the MIDI Editors.

Besides the long known method of creating MIDI CC data in Steps, these can be now converted to Ramps, and then 
into Curves.

How to create Ramps/Curves

Recording or drawing in MIDI CC data will always default to Steps at first, the possibility to use Ramps and 
Curves is an edit-operation afterwards.

An additional option has been added to decide if Steps or Ramps are the default, see further down 
below 

Use the handle in-between two MIDI CC events to change it to a Ramp or Curve:
Grab the handle and move it to create a Curve into the desired shape
Double-click the handle to convert a Step into a Linear Ramp, from there grab the handle to shape it 
to a Curve
Double-click also switches from Curves back to Ramps and then back to Steps
Use the Info Line "Curve Type" field to convert a selection of MIDI CC events from Steps to Ramps
/Curves and vice versa

Please note: A massive load of MIDI CCs used as Ramps or Curves can impact the performance of the 
application

Playback Details

When using Steps there are discrete MIDI CC events which are played exactly as they are
As soon as you switch to Ramps/Curves, the data between two MIDI CC events is interpolated and internally 
rasterised to a suitable MIDI data resolution

There is a trade-off to make between super accurate precision and the amount of data to send out
The resolution is essentially the same as when using MIDI CCs for Automation in the Project window

When using "Freeze MIDI Modifiers" or "Merge MIDI in Loop..." you can see the actual 
result of the rasterised data

When exporting MIDI files, data will be rasterised automatically
When moving MIDI Part boundaries, notice the following:

When changing the start of a MIDI Part in-between two MIDI CC events, the next event after the 
start of the MIDI Part is played back
When changing the end of a MIDI Part in-between two MIDI CC events, data is played exactly up 
until the end of the MIDI Part
You can follow this by the visualisation of the MIDI CC data in the Controller Lane; data not played is 
shown as greyed out - or better:  hat  ou  ee  s  hat  ou  earW Y S I W Y H

Data value feedback

This is a collection of small improvements:

In previous versions, Controller Lanes had a small value feedback underneath the name of the Lane to show 
the value at the mouse cursor position; this was meant as an aid for drawing/editing data at specific values

This value value feedback now shows the current   at the Cursor position, similar to the Track Control 
featured at Automation Lanes in the Project window and is updated when the Cursor moves across 

datathe 
To provide a good value feedback for drawing and editing data, make use of the following improvements:

When hovering over a MIDI CC event, you will see a tooltip-like display showing you the position and 
value of the event underneath
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When drawing or editing data with the Object Selection or Draw tool, you will get an immediate value 
feedback the same way, right there where you create or edit the data
When enabling the Status Line the "Mouse Value" field will also show you the value at the current 
mouse cursor position

These improvements also apply to events on Automation Lanes in the Project window, you no longer have to 
select an Automation event to read-out its value in the Info Line

Re-organised Lanes management menus

In the Editor the bottom-left area has been re-organised the following way:

Use the "+" (Create a Controller Lane) button for a menu with everything related to adding a Lane
In this menu, Lanes which have data are marked with a more obvious diamond-shaped symbol

Use the "arrow down" Controller Lane Setup button for a menu with everything related Lanes in general

Select Steps or Ramps as default curve type

In the Controller Lane Setup menu you can select whether you want to have "Steps" or "Ramps" as the default curve 
type:

This option only affects data which is created by mouse, resp. when drawn in by Tools
Tools like the Pencil resp. Draw and the different Line tools respond to this (Square will always work 
as "Steps" though)
Recorded MIDI CC will always be created in Steps

The selected option is handled as an application preference, which means it is a global setting and 
remembered as set - independently from your projects

The default is "Step"

Cut/Copy/Paste Controller Events Improvements

These additional edit functions have been added to the Controller Lane context menu to improve their.



Cubase 11 Beta Documentation Page 14 of 56 Steinberg Media Technologies GmbH

They are available when using the right-click menu within the left-side Lane area
Paste will insert data at the current cursor position, use Paste at Origin when the data should be inserted at 
the same position as the copied one
When data is pasted over already existing data it now gets properly replaced in that time range (unlike 
before, where old and new data was strangely mixed up)
To copy data from e.g. CC1 to CC8 make sure to click into the CC8 Lane before using Paste
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Pitchbend Editing Improvements

Pitchbend Editing Improvements

Have you ever tried to start or end on clean semitones with Pitchbend data? If you are a virtuoso in playing and 
recording with a Pitchbend wheel, you may not care as long as you are satisfied with your performance. But what if 
you want to edit the data afterwards? Or how to program exact Pitchbend moves for a synth bass line?

Not only can you make use of the new Ramps and Curves for MIDI CC data, you can do the same for Pitchbend, with 
the additional possibility to divide the Pitchbend Range into steps of semitones, incl. Snap to Semitones:

Open the Pitchbend Lane in a MIDI Editor, notice the new controls underneath the name label of the Lane
By default, the Pitchbend Lane will open to show the previous, rather abstract Pitchbend Range of +/-
8192 in musical +/-2 semitones and cents, with semitones indicated by horizontal grid lines
When drawing or editing Pitchbend data and you want to hit exact semitones, make sure "Snap to 
Semitones" is enabled

Now it's possible to create Pitchbend data very precisely and predictable in semitone steps, and its much easier to hit 
the center line (= no Pitchbend)

Click the "Set up Pitch Bend Display button for further options:

You can decide to have the semitone grid enabled, but without Snap enabled - this give you a visual aid but 
its also possible to deviate from semitones in cents

Notice how the value feedback also indicates semitones and cents, instead of the abstract Pitchbend 
MIDI value

Of course the actual Pitchbend Range is dictated by the settings within the VST or MIDI Instrument, and will 
differ from sound/preset you use

Thus, to make the best of this feature, make sure the Pitchbend Range settings of your sound 
matches the settings of the Pitchbend Lane
We allow a Pitchbend Range of max. +/-96 semitones, this will cover all bases of sounds and 
instruments

High values for the Pitch Bend Range may not allow to show all semitones with a dedicated 
grid line, resp. you may want to increase the height of the Pitchbend Lane.
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Grid lines for indicating octave boundaries and for every 6th semitone within octaves are drawn 
more pronounced than others.
The Up and Down Range can be set up asymmetrical when you disable " ", Link Up and Down Rage
the center-line will stay in the center all the time
Existing Pitchbend data will not be scaled or otherwise adapted when you decide to change the 
range at the Lane, its about a musical representation of the data in a graphical way that makes 
editing a breeze

The settings for the Pitchbend Lane works per track, so different tracks (using different instruments) can be 
all set up as needed and useful
The settings for all Pitchbend Lanes are stored and recalled in the Project file
The Pitchbend Lane can also work as in previous versions, just make sure that the "Snap to Semitones" 
button is disabled
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Global Tracks in Key Editor
In the Key Editor it is now possible to show data of Global Tracks directly inside the Editor, together with the MIDI Part 
data. This allows you to edit data in context of data on Global Tracks with a better overview and also as a visual 
reference of what is going on in the Project at specific time ranges, all without the need to leave the Editor or look at 
the Project window.

The following Track Types are supported within the Editor

Tempo, Signature, Chord, Ruler, Arranger, Video, Markers and Transpose

Some pre-conditions apply

The Tracks you want to see within the Editor must have been created before in Project window
The order of these tracks within the Track List in the Project window is also used within the Editor

If you want to re-order them, do this in the Project Window
Specific configurations of these Tracks need to be done also in the Project window, but are reflected in the 
Editor then

E.g. "Show Scales" for the Chord Track, the tempo range settings for the Tempo Track, etc.
Global Tracks are only in the Key Editor in its separate Window

How to enable the Global Tracks in the Editors

Notice the "Global Tracks" section in the Editor Inspector
Expand it, then check the items you want to see

If you want to quickly toggle the display of your selected items, click the "Show/Hide Tracks" button 
at the right side of the Inspector section

You can assign a key command to this!
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Once you enable tracks in this section, the upper part above the MIDI Part Data display automatically grows 
as needed and also shrinks again when you un-tick tracks

In other words: The combination of selected items determine, how much space us used within the 
Editor to make efficient use of the available overall screen space

The tracks itself can be re-sized to a certain degree, also having an effect of the used space. We deliberately 
decided to not introduce a scroll-able area

You can use the Shift G/H key command to zoom all tracks at once
The setup of your Global Tracks within the Editor are stored and recalled with your project files

About editing event data of Global Tracks

Its not just a passive display: In fact you can select, edit, add all event data types of Global Tracks within the 
Editor

The data you edit here is of course reflected back to the Project window, it is the same data
You can utilise the Info Line for additional parameters
You can use all the Tools as known from the Project Window
There is in fact no deliberate restriction of editing the data

About focus handling and indication

A lot of key commands and commands in general work on the active focus
You may need to click into the respective area first for proper behaviour
The default focus is set to the MIDI Part editing area

The editor area which has the current focus is indicated by the usual white and   focus frame, the non-solid
active area is drawn with a dashed pattern for visual separation.

Default Track Heights in Editor

The following default Track Heights will be used for the different types of Tracks, until you resize them. The last used 
height is then applied until you remove and add the same track type again.

Tempo, Chord: Height 2
Video: Height 3
All others: Height 1
The Ruler Track can not be resized beyond height 1
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Scale Assistant & MIDI Editing in Key Editor
We have introduced a new section in the Inspector of the Key Editor: It is the "Scale" section. It allows you to select a 
musical scale to indicate the pitches, which are part of the selected scale.

Once you enable the indication, pitches which do not belong to the selected scale are drawn in black into the Editor 
background. This can be used as a visual guide when you want to ensure to place/edit notes only on pitches valid for 
the selected scale.

Alpha 4: The color scheme has been   and now works in conjunction with the Editor Background Color. improved
Darker coloured pitch-lines represent notes which are not in the Scale. When using the dark default color setup in the 
Editor the current indication may be perceived as not strong enough, this will be corrected soon as well.

Set up a Scale

To setup this feature, there are different types of sources from where to derive the indication:

Scale in Editor: When selected, use Root key and Scale selector menus underneath
This is a local setting for within the Key Editor and does not require a Chord Track to be 
present

The indication can be also taken from the Scale or Chord Events on an existing Chord Track in the Project, in this 
case select from:

Chord Track: Chords & Scales: Indicates the pitches according to Chord and Scale events from 
the Chord Track
Chord Track: Chords: Only the pitches used by the given Chords are used for the indication
Chord Track: Scales: Only the pitches used by the given Scales are used for the indication
When one of these three Chord Track options is selected, notice how the indication in the Editor 
background adapts accordingly at the positions, where Chord/Scale events change on the Chord 
Track

The settings are recalled with each time you open the Editor, so you just need to set it up once when working across 
different MIDI Parts.

Pro Tip: When you set the indication to take its data from the Chord Track, check the "Global Tracks in Editor" 
feature to show a Chord Track with Chord and Scale events right within the Key Editor! This way you have all musical 
context information right in front if you while editing MIDI note data. No looking back and forth between Key Editor 
and Project Window anymore...

Scale Suggestions based on Notes

If you have a MIDI Part with multiple notes of different pitches, Cubase can narrow down a list of matching scales to 
select from by using the "Scale Suggestion". A number of available scales will be shown and can be selected via the 
"Choose..." menu.
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The following conditions have to be met:

"Scale in Editor" is selected
If there is no note selection, all notes are taken into account in suggesting matching scales
When you select notes, only notes from within the selection are taken into account

Quantize Pitches

It is probably self-explaining: Once you have the indication enabled, all notes which are on pitches outside of the 
scale will be re-pitched to pitches of notes within the selected scale when you use "Quantize Pitches". This way you 
can quickly transform notes of a MIDI Part to different scales (or Scales/Chords on the Chord Track). The application 
considers the original pitch of the notes to prevent that several attempts of "Quantize Notes" does not end up in rather 
useless piles of notes.

Snap Pitch Editing

So far it was all about indication of pitches but you are in command to place and edit notes on whatever pitch you 
want. With "Snap Pitch Editing" you can engage a kind of auto-pilot for editing:

When enabled, you can  place notes on pitches outside of the scale. This applies to:no longer
Creating notes with mouse
Moving notes in pitch up/down by mouse or key commands

This also works for a multiple selection of notes on different pitches. This makes 
transpositions actually scale-aware, directly within the editing process
When using "Pitch" from the Info Line, the limitation does not apply. This way you can still 
break out of the limitation - if you want to - without the need to disable this option 

Using the Draw and different Line tools from the Toolbar, incl. the Paintbrush Tool

So far, this feature is meant as an Editing Helper. But you can also transform the live input when recording into the 
Editor.

Snap Live Input

When enabled, incoming notes are automatically corrected in Pitch according to the settings within the Scales tab. 
This means you can monitor/record the corrected result immediately while playing in an open Editor.

This mode kicks in when the Editor has the recording focus (Record in Editor button must be enabled and 
shown in red)!

Try this for experimentation:
Setup a Chord Track with some Chords, playing a pad sound
Create another Instrument Track and load e.g. a bass sound
Open the Key Editor, in the Scale section enable "Use Chord Track" in Mode "Use Chords only" 
Enable "Map MIDI Thru", make sure "Record in Editor" is enabled
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Start Playback, now just keep playing the bass sound on one pitch on the MIDI keyboard and notice 
how the pitch will adapt automatically to the Chords you have set up before

Alternatively, check the "Live Transform" feature from the Chord Track, which can be used using also without   the 
Editor focus. Record in    More details to this can be found here: https://steinberg.help/cubase_pro/v10.5/en

/cubase_nuendo/topics/chord_functions/chord_functions_using_live_transform_t.html

Event Coloring  for Scale/Chords

The Key Editor toolbar contains the "Event Colors" selector. The mode "Scale/Chord" can be used to indicate whether 
or not notes belong to Scale and/or Chords notes by a color scheme for the notes itself. In the past this required a 
Chord Track to work but now it takes the Editors Scale section settings into account, meaning it's not required to have 
a Chord Track in order colorise the Events anymore. The different colors are described in their meaning in more detail 
now and the default set of colors as been adjusted.

https://steinberg.help/cubase_pro/v10.5/en/cubase_nuendo/topics/chord_functions/chord_functions_using_live_transform_t.html
https://steinberg.help/cubase_pro/v10.5/en/cubase_nuendo/topics/chord_functions/chord_functions_using_live_transform_t.html
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Set up Musical Scales

In previous versions the scales Cubase knows about was fixed and could not be changed. With the "Musical Scale 
Setup" window we open up the management of scales to you. You can find this window in menu "Project > Chord 
Track > Set up Musical Scales..." and also in the menu list available at places where to select Scales.
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The following management functions are available:

Add Scale: Creates a new, nameable entry, use the mini-keyboard to define the pitches for the scale
To define a new scale it always starts at key "C"

Factory Defaults: Resets all scales to factory content
Use: When you remove the checkmark of each scale entries, these scales won't appear as part of Scale 
suggestions anymore
Rename: Click on the name field
Keyboard Widget: Click on the keys to define the notes belonging to the scale
Play Icon: Plays the scale using the current selected/rec-enabled etc. MIDI or Instrument Track
X: Removes a selected scale entry

Please note: Scales are managed not just for the currently open project, but for the whole application. This makes it 
easy to customise the set just once. When you remove or rename scales which have been already used in specific 

you need to review such projects as the used scale will be unknown/unavailable to such projects then.projects before, 

The list of scales you manage in this window are all reflected back to the areas within the application where Scales 
can be selected:

In Key Editor - "Scale in Editor"
Scale events on the Chord Track
Scales within the MIDI Transpose function
Scales within MIDI Inserts > MIDI Modifiers 
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Pitch Visibility in Key Editor
In the Key Editor it is now possible to condense (or "fold") the amount of pitches to be shown by two distinct "Pitch 
Visibility" options. You can find these options in the Toolbar of the Key Editor:

Show All Pitches

This is the normal and known mode of operation: The editor, resp. the left-side keyboard widget will show all possible 
pitches in full range.

The next two modes are removing pitches from the view by different criteria.

Please note: No actual note events are removed. It is about visually hiding pitches, similar to the Track/Channel Visibi
lity features or the Drum Sound Visibility feature in the Drum Editor.

Show Pitches with Events

When selected, the view is reduced to just show the pitches on which note event exists. All other pitches are hidden. 
This can save a lot of space on screen, especially when the range of note events in the MIDI Part span multiple 
octaves.

Editing single MIDI Parts: The visibility of pitches follows the MIDI Part selection, so you always get a properly 
condensed view in context of the MIDI Part and its note event content.

Editing multiple MIDI Parts: When editing multiple MIDI Parts, the view is condensed according to the sum of all 
existing note events in the different MIDI Parts. Also, extending/reducing a selection of MIDI Parts will update the 
view on-the-fly.

Moving Notes in Pitch: These are the general rules when moving note events in pitch up/down:

You can move notes up/down only within the visible pitches at that time (key command: Navigate - Up/Down)
This applies to moving notes with the mouse or by using cursor keys up/down. In other words: The visible 
pitches won't change when moving notes

However, if you want to break out of this you can use the "Pitch" value in the Info Line to move an 
event on a pitch currently not visible. In this case the visibility will update itself accordingly

You can move notes up/down by whole octaves (key command: Navigate - Add Up/Add Down on [SHIFT]+
[Cursor Up], [Cursor Down])

This operation will extent the visibility of pitches if needed. This makes it easy to create octave jumps 
within a condensed view of pitches

It is also possible using "Inversions" or "Drop Notes" from the Chord Editing section in the Editor Left Zone, 
also here the view will update on-the-fly

Show Pitches from Scale Assistant
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This mode hides all pitches from view which are not matching with the current Scale Assistant settings.

You will see all pitches belonging to the settings used in the Scale Assistant section
These pitches will be shown across the full range of octaves

Use Editor Scale: In the easiest case only notes according to the selected scale in the Editor remain 
visible. However, if the MIDI Parts contains note events on pitches which are not matching according to the settings 
of the Scale Assistant, they will be also shown anyway! This is intentional to prevent confusion of hearing notes that 
would be invisible otherwise,  settingsdue to the   you use.

See screenshot example above:

The orange "F1" does not match to the scale.
It will show up anyway and on the left-side keyboard this pitch is then marked with an exclamation mark

Using the Event Color mode "Scale/Chords" from the Editor Toolbar makes it even more visually 
prominent

Depending on the musical context, you may want to leave such notes as they are. But if you move them to a 
matching pitch the view will clean-up accordingly, once there are no more non-scale notes in the MIDI Part

Use Chord Track: This is an extension in regards of which pitches will remain visible. It now depends on the data
/events on the Chord Track itself in combination with the Chord Track Mode selected for the Scale Assistant.

When editing a MIDI Part, it is calculated which Chord/Scale events on the Chord Track are existing in the 
time range of the MIDI Part
According to this the, the sum of all valid pitches across that time range is presented as visible pitches

So, even if scale and/or chords are changing over time and even if they do not share the same 
pitches you get a properly condensed view and won't miss a pitch

Chord Track Mode - Scales: The sum of valid pitches across varying scale events is used to set up the list 
of visible pitches
Chord Track Mode - Chords: The sum of valid pitches across varying chord events is used to set up the list 
of visible pitches
Chord Track Mode - Chords & Scales: A combination of both options above

General Notes

The option you have used at last is remembered across all instances of the Key Editor and also acts as a 
global application setting across projects
In situations where a Pitch Visibility option would lead to a situation that no pitches at all can be visible, the 
application automatically reverts to show all pitches again
The Editor remembers the last used vertical zoom state for the note event height, though for "Show Pitches 
with Events" a separate state is remembered.

Key Commands

There is access to the different Pitch Visibility options by key commands:

Category: MIDI > Key Editor: Show Pitches...
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Keyboard Widget Improvements

As a surrounding topic the left-side keyboard widget had been improved. The keyboard is able to hide keys now, 
dependent of the Pitch Visibility Mode and changes to a more abstract design; also every key gets its own label then. 

The vertical mouse position indicator has been refined and is shown on the right edge of the keys, always 
following your vertical mouse movements
Selected notes will reflect their color on to the keys of the keyboard more prominently
The left edge now shows a "zooming"-zone for the vertical height when you hover with the mouse over it
There are no more extra gaps between the pitches B to C and E to F in the note event editing area, leading 
to a more compact and equally spaced view of note events across the different pitches. 
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Sampler Track V2
For Cubase 11, we introduce a new revision of the Sampler Track / Sampler Control. The new version includes some 
of the most higly anticipated feature requests.

LFOs For Parameter Modulation

Sampler Control provides two monophonic LFOs. Monophonic means that the LFOs are only calculated once and 
feed all voices at the same time. The two LFOs are shared between the supported parameters.

Destinations for the LFOs can be:

Pitch
Filter
Volume
Pan 

Each module section has a switch to choose which of the two LFOs should modulate the parameter. A dedicated 
control allows the user to adjust the LFO amount for each destination parameter.The moulation can be in the negative 
or positive range. Center position means no LFO modulation.

The LFO section can be found on the Mod Page. Here you'll find the Envelope for the specific module and the shared 
LFO section. A control allows you to switch between LFO 1 and 2. 

LFO Waveform and Shape

Sine produces smooth modulation, suitable for vibrato or tremolo. Shape adds additional harmonics to the 
waveform.

Triangle is similar to Sine. Shape continuously changes the triangle waveform to a trapezoid.

Saw produces a ramp cycle. Shape continuously changes the waveform from ramp down to triangle to ramp 
up.

Pulse produces stepped modulation, where the modulation switches abruptly between two values. Shape 
continuously changes the ratio between the high and low state of the waveform. If Shape is set to 50%, a 
square wave is produced.

Ramp is similar to the Saw waveform. Shape increasingly puts silence before the sawtooth ramp up begins.

Log produces a logarithmic modulation. Shape continuously changes the logarithmic curvature from negative 
to positive.

S & H 1 produces randomly stepped modulation, where each step is different. Shape puts ramps between 
the steps and changes the S & H into a smooth random signal when fully turned right.

S & H 2 is similar to S & H 1. The steps alternate between random high and low values. Shape puts ramps 
between the steps and changes the S & H into a smooth random signal when fully turned right.

Frequency

Controls the frequency of the modulation, that is, the speed of the LFO.
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If Sync Mode is activated, the speed is specified in fractions of beats.

If Sync Mode is deactivated, you can set up the frequency in Hz.

Retrigger

Defines whether the LFO is restarted with the specified start phase when a new note is triggered. This parameter is 
available for the sync modes Off and Tempo.

Off – The LFO is not restarted.

First – The LFO is restarted when a note is triggered and no other note is held.

Each – The LFO is restarted each time that a note is triggered.

Sync Mode

Specifies how the LFO speed is set.

Off – The speed of the LFO is set in Hz.

Tempo – The speed of the LFO is set in note values. The resulting rate depends on the tempo specified in 
the host sequencer.

Beat – The speed of the LFO is set in note values. The resulting rate depends on the tempo specified in the 
host sequencer. In addition, the current start phase is calculated based on the current position.

Select this option to synchronize the LFO restart to the transport of the host application and align it to the beats of the 
project.

Phase

Sets the initial phase of the waveform when the LFO is retriggered.

Rnd (Random Phase)

If this button is activated, each note starts with a randomized start phase.
 
Note:
The Phase control cannot be used if Rnd is activated.

MW: Activate option if you wan to scale the output level of the LFO using the modwheel. This way you can, for 
example control the vibrato of the sound using the modwheel.

Sample Slicing

Sampler Control allows you to slice a sample into several pieces which are then mapped to the keyboard, so that 
every slice can be played individually. It also creates a corresponding MIDI file which can be dragged to the project to 
play the slices either in their original order or completely rearranged.

To slice a sample switch to the Slice tab, select the desired slice detection mode and adjust the related parameters. 
The slices are immediately mapped to the keyboard and can be played. You can at any time manually adjust the 
postion of the slice markers or add or remove slices via Alt-Click.
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You can preview a slice by clicking in the slice range. You can remove a slice marker by holding Alt (Win) / Cmd 
(Mac) and left click on a slice marker . Holding Alt (Win) / Cmd (Mac) and clicking in the waveform allows you to add 
slice markers. 

Toolbar

Tempo: Displays the tempo of the loop, as read from the sample file or calculated from the sample length. You can 
adjust this value manually.

Bars/Beats: Shows the length of the sample found by the automatic tempo detection, in bars and beats. You can 
adjust this value manually, which has an effect on the grid and the tempo.

 

Parameter Section

Slice Detection Mode: The slice detection automatically sets slice markers in the sample waveform. The following 
modes for slice detection are available:

Transient mode allows you to specify the minimum peak level that a transient needs to become a slice 
marker.

Grid mode sets the slice markers according to a beat grid.

You can combine the Transient and Grid modes to detect slices that match both conditions.

In Manual mode, no automatic slice detection is performed. Instead, you can add and remove slices 
manually by Alt-clicking in the waveform.

Threshold: Determines the minimum level that a transient must have to be detected as the start of a new slice.

Min Length: Determines the minimum length of a slice. Use this to avoid creating unwanted short slices.

Grid Catch: In Transient+Grid mode, you can use this control to specify how close to the grid a transient marker must 
be.

Fade In/Out: Sets the length of the fade in and the fade out for all slices of the loop.

MIDI Trigger Part 

Slicing a sample will create a MIDI file that allows to trigger the slices corresponding to their original position within 
the sample file. This MIDI file can be transfered to your project by dragging MIDI Drag icon to the Sampler Track. A 
MIDI Part with the corresponding trigger notes will be created which allows you, to edit the notes to your taste.

Miscellaneous

Sample Normalize and Gain Control

In the Toolbar, you'll find a new section to normalize or gain adjust the sample. Click the Normalize button in the 
toolbar to normalize the sample by detecting the highest peak level in the sample and adjusting the "Sample Gain" 
accordingly to reach the predefined "Normalization Level".

A gain control allows you to lower the gain for the sample or to boost the gain up to +96db.

Sample Trim

In the Toolbar, we added a Trim control which allows you, to crop a sample by its selected range,

Trim: Trims the sample, either to the selection, or whithout a selection, to the range that is set with the sample start
/end markers.



Cubase 11 Beta Documentation Page 30 of 56 Steinberg Media Technologies GmbH

Revert to Full Sample: Undoes the trimming, so that the entire sample is restored.

 Waveform view in the Envelope display

In the envelope views on the Mod page,  The Sampler Control always shows the resulting rendered sample. That 
means, that any parameter change will be reflected in the Envelope display.

Key Follow for Filter Cutoff

For the Filter module, we added a Key Follow parameter. This allows you, to adjust a cutoff modulation using the note 
number. Increase this parameter to raise the cutoff with higher notes. At 100%, the cutoff frequency follows the 
played pitch exactly.

Envelope Sync Mode

Synchronizing Envelopes to the tempo of the project

You can synchronize the envelopes to the tempo of your project. This allows you to set envelope times that relate to 
musical time intervals, regardless of any tempo changes.

Procedure
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1.  

2.  

3.  

Click Sync to activate sync mode for the envelope.

 
On the pop-up menu located to the right of the Sync option, select a note value.
This sets the note resolution to which nodes will snap to when coming close enough
 
Note:
The Time field of a node displays times in fractions of a whole note. The fraction is always reduced to the 
smallest possible value. 2/16 is displayed as 1/8, for example.
 
To use triplet note values, activate the Trpl option.
 
Note:
You can also enter note values manually in the Time field.
Envelope nodes that do not exactly match a note value display the closest note value.

Nodes that exactly match a note value are indicated by a red dot inside the handle of the node. This is useful if you 
switch the grid between triplets and normal note values, for example. The triplet nodes still indicate that they match a 
note value, even if the grid shows normal note values.

Mono Legato Mode

In the Toolbar, we added a new Mono Mode - Legato.

This option becomes available, when Mono mode is turned on. When activating  this option, for legato played notes, 
only the pitch of the sample is set to the new note, but the sample is not retriggered and also the envelopes keep 
running.

Lock Parameter Option 

In the Toolbar, you'll find a new Option to Lock all parameters when replacing the sample.

Acitvate this option if you want to keep the current Sampler Control parameter settings when exchanging the sample.

Note: Parameters that are directly related and read from the sample, like for example sample start/end, loop start/end, 
root key and tempo are not kept and taken from the new sample.

Pitch Octave Parameter

For the Pitch module, we added an Octave selector. This extends the available pitch range tremendously.

The coarse knob hase been replaced by a  coarse valuebox. This was done to make space for an octave parameter.
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   Adjusts the pitch in octave steps (+/-4 Octaves).Octave:

Fingered option for pitch glide

In the pitch module, you'll find a new "Fingered" option. Activate this parameter to glide the pitch only between notes 
that are played legato

Extended Pitch Band range

The Pitch Band Range is now extended to +/- 24 semitones 

Sample playback quality settings

Sampler Track/Control allows you now to adjust the playback quality for the loaded sample.

When samples are played with another than their original pitch, Sampler Track calculates the transposed versions in 
real time using different algorithms, providing different levels of quality.

Standard
High
Best
Extreme 
Vintage - with extra sub modes/settings

Changing the quality setting is particularly noticeable in the high frequencies. The higher the setting, the better the 
suppression of artifacts. For samples with little high-frequency content, you can use the Standard option.

If Quality is set to Vintage, you can make the following settings:

Rate Reduction allows you to specify a sample frequency, to simulate the lower sample rates of early 
samplers.

Bit Reduction allows you to select the bit depth that was used by early samplers.

Turntable emulates the memory-optimized workflow of the past, where turntables were sampled at a speed 
of 45 RPM to record shorter samples, and then tuned down again to correct for the change in pitch. If you set 
this parameter to 78 RPM, you can increase the vintage artifacts that are produced.

Note: The quality settings are also used in Slice mode.
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REX V.1&2 file support

Sampler Track/Control allows you now to import REX1 and REX files.

You can load these like any other sample, using drag and drop or Import Audio File dialog (you need to set file type to 
"Any") . In both cases the .rex and .rex2 files are converted into wav-files, which are written into a "wav" folder right 
next to the original file.

Sampler Track switches automatically to Slice mode and sets the slice makers as they were defined in rex file.

Move Sample Start/End- and Loop/Start- Range 

The Start/End- and Loop Start/End- range can now be moved simultanouslyr in the waveform display. This allows you 
to quickly check and audition different ranges of the loaded audio sample. Or to check and audition different loop 
positions without altering the loop duration.

Sample Start/End: Moving the mouse cursor in between the Sample Start and End marker, at the heigth of the 
marker flags, a connecting bar appears. Also the cursor changes to a hand. Now you can move both marker 
simultaneously.

Loop Start/End: Moving the mouse cursor in between the Loop Start and End marker, at the heigth of the marker 
flags, a connecting bar appears. Also the cursor changes to a hand. Now you can move both marker simultaneously.

Extended Transfer Options (incl. Backbone)
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The Transfer function allows to transfer the sample and settings of the Sampler Control to the following plug-
ins:  GrooveAgent (SE), HALion, Padshop and Backbone.

Note:
There are parameters that are not available in some of the destination plug-ins and therefore will not be transfered or 
adpated to the destination instrument.

Features and Limitations

GrooveAgent (SE)
LFO settings are not used
Filter Key Follow is not used

Padshop
Sample Trim is not used
Transfer in Slice mode uses selected slice 

Transfer in Warp mode sets grain mode to 2 grains with the same speed
Backbone

LFO settings are not used
Transfer in Slice mode uses selected slice

Transfer in Warp mode turns Resynth mode on and sets the same speed
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Score Editor Extensions

Properties Inspector & Editor

In the Score Editor, you can now open a right zone which features a Properties Inspector for various score elements. 
Depending in what you have selected, you get matching options and settings for that elements. It eliminates the need, 
to open the respective windows and panels. Here is an overview of what you can setup and edit there:

Notes

All options from the note info dialog, as already described in the manual.
New option: "scale" (next to the "note head" popup)

Allows scaling of individual note heads
Value range: 1% - 250%

Tab "Symbols" (exclusively in the right zone)
Display of "note linked" symbols.
Symbols that are present on a note are displayed selected
Click to add/remove a symbol
Four areas:

"Expression Map" - Symbols from the current Expression Map
"Favourites" -  all "note linked" symbols from the "Favourites" palette
"Selected" - Symbols in none of the above, but currently linked to the selected note

Rests

Multi Rests (same as in Scores > Settings > Layout)
Multi Rest Options (3 settings; same as in Scores > Settings > Project > Notation Style > Multi Rest)

Bar Lines

Type of bar line. including "Brackets"-option  (same as in the dialog)
"Old Choral Style" / "Break with Barlines" / "Break Last Brackets" / "Hide First in Parts" - also in Scores > 
Settings > Project > Notation Style (all settings from the "Barlines" Section)

 Bar Number

"Offset": Same as when double-click on a bar number (which, in fact, is a setting for the current layout)
All options from Scores > Settings > Project > Notation Style (Bar Number Section)
Font Settings: same as in Scores > Settings > Project > Project Text > Font > "Font For" > Bar Numbers (so 
this an option for the entire project,   for individual staff names )not

Clef

"Type" of clef (same as in dialog appearing on double click)
"Show Warnings" / "Small Clefs" - also in Scores > Settings > Project > Notation Style (all settings from the 
"Clefs" Section)

Key

Number of Accidentals / Key
"Global Keys" / "Show Warnings" / Show Naturals" - - also in Scores > Settings > Project > Notation Style (all 
settings from the "Keys" Section)

Staff Names

 Button, that opens the edit dialog (same as when double-click on a staff name)
Project Settings: same as in Scores > Settings > Project > Notation Style > Staff Names)
Font Settings: same as in Scores > Settings > Project > Project Text > Font > "Font For" > Staff Names (so 
this an option for the entire project,   for individual staff names )not
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Layout Settings: "Sgow Staff Names" from Scores > Settings > Layout

Graphic

The tab is for all purely "graphic" objects - note-linked and non-linked symbols.
Size (default is 48 Points)
When a "Dynamic" is selected, it's type can be chosen (from "pppp" to "ffff")

Bar Handles

Options for Move/Copy operations (same as in the dialog that shows up after double click on a bar handle))

Text

All options found for font settings, as already described in the manual.

 Chord Symbols

Chord Symbol Editor (same as the popup-window that is used in the project window when editing chords 
from the chord track; the column for bass note is replaced with a value input control)

Note Length and Velocity Overlays

It is now possible to show dedicated overlays for notes to edit aspects like note lengths and velocities in a rather key-
editor like fashion.

To activate the overlays, use the button on the Toolbar "Note Length Overlay" (you may want to check the item in the 
"Set up Toolbar" menu if you can not find it).

Key Command can be assigned (initially unassigned)
The overlay displays always one bar, following the mouse movements.

The overlay is extended to the right, if the bar contains notes longer than one bar
The overlay is extended to the left, if a note starts it's display in the current bar, but starts playing in 
the bar before (in other words: if the   shows the start of a note in the current bar, display quantize
but the   starts in the bar before).MIDI position

The length display follows the pitch of the notes: lowest notes in the lowest column
Overlaps are resolved automatically (no overlapping "length bars")

There are several options for coloring the display, available from the menu next to the overlay activation 
button:

Colorize by Part Color
Colors by channels (which is especially useful when working with polyphonic voices)
Color by Pitches
Color by Velocities

The "Colorize Score Notes" option applies the chosen color scheme to all notes in the range of the overlay
Buttons on top of the overlay view:

"X": close overlay
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"V": activated - velocities are shown; deactivated: length display
"S": snap positions, according to the quantize value set in the tool bar
"L": Lock overlay. Following the mouse positions is suspended; the overlay stays at the same position
"+"/"-": expand/shrink the overlay vertically
(Arrow up/down): move the overlay to the top / bottom of the staff

Operations (using the mouse)

Length Mode:
Move notes (arrow cursor)
Right / edit length (size cursor)
Left / move start point without affecting the end (tilted size cursor)

Velocity Mode:
Draw velocity (pencil cursor)
Fine-tune velocity (size cursor). Note that the display doesn't follow the mouse one by one. That is 
intended to allow fine tuning of velocity values

SMuFL Font Support

What is SMuFL? Please read on here for an introduction: https://www.smufl.org

Two new fonts are supported in Cubase 11, both following the SMuFL standard:

Bravura (the standard font for Dorico)
Petaluma (the Jazz font available in Dorico)

The fonts can be selected in Scores > Settings > Project > Project Text > Score Font.

The selection is used for the entire project.

Scaling of Note Heads

Note heads can be scaled now.  specialisThis is a feature required to support SMuFL-fonts: These fonts don't provide 
ed symbols for small/grace notes, but require scaling of the "regular" note head symbols instead.

Right zone, "Note Event", "Scale"-control, under the note head popup-up.
Scale range: 1% - 250%

Score Rendering Improvements

In order to allow integration of the SMuFL fonts, a lot of changes needed to be made to the rendering of the scores to 
the screen/printer. Some of these changes are just "fine tuning" for resolution-independent, pixel-accurate displays. Ot

 E.g. the "spacing" will differ, resulting in hers may effect compatibility with earlier versions of Cubase.
incompatible display of the scores. This will especially affect scores with a lot of corrections of the user, by using the 
"spacer" tool.

Note heads, stems, beams, and flags: The positioning of these elements should be pixel accurate for all fonts 
and in all display resolutions.

Compatibility: No issues
Accidentals: Stacks of accidentals require less space in many situations. The overlap detection between 
accidentals has been revised/rewritten to allow "undercuts". This results in a "denser" display of complex 
chords.

Compatibility: The spacing has "more space" to deal with now, which might render manual spacing 
corrections obsolete.
Manual corrections of "Accidental Distance" (in the note info dialog) might cause conflicts, e.g. by 
introducing collisions between accidentals in Cubase 11 that weren't there in previous Cubase 
versions.

https://www.smufl.org
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Squasher Plug-in
The Squasher is a multiband effect with a combination of an upward and a downward compressor, saturator and gate 
per band. The output signal can sound highly compressed with a strong coloration and a characteristic pumping 
effect, often desired in modern productions.

You can choose between the internal and up to three different signals for side-chaining per band.

The user interface can be expanded for a deep dive into additional parameters - but the main top section has been 
designed with ease of use and focus on the essential controls.

Main Top Display

There are two modes you can toggle at the right side:

The spectrum display in the upper half of the panel is where you set the width of the frequency bands
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The vertical value scale to the left shows the gain level of each frequency band. The horizontal scale 
shows the frequency range.

The compressor characteristics display visualises the settings of Up/Down Ratios and Up/Down Threshold
Parameter Linking: Links the parameters of the same type in all bands in a module. 

This allows you to edit parameter values of all bands in a module simultaneously.
Two link modes are available: Absolute and Relative.

If Absolute Mode is activated and you edit a parameter value in one band, the 
corresponding parameter values in the other bands are set to the same value.
If Relative Mode is activated and you edit a parameter value in one band, the corresponding 
parameter values in the other bands keep their relation.

Bands: Allows you to set the number of bands from 1 to 3.
Input: Sets the input level.
Output: Sets the output level
Mix: Sets the ratio between the input (dry) and effect (wet) signals.
Up/Down Ratio: Sets the ratios for the upward and downward compressors for more or less "squashing 
effect" per band.
Up/Down Threshold: If the input signal is below the threshold, the upward compressor raises the level 
according to the amount parameter, if the input signal is above the threshold, the downward compressor 
lowers the level according to the amount parameter.

You can click on the area between Up and Down and drag the mouse to move the center graphically.

Parameters: Shows/Hides the section for more parameters, affecting the squash effect.

Attack: Sets the attack time value for both the upward and the downward compressor per band.
Use low attack values to soften transients, use high attack values in combination with higher Drive va
lues to make the transients sound crunchy.

Release: Sets the release time value for both the upward and the downward compressor per band. Use low 
values for a pumping effect, high values to make it sound tight.
Drive: Sets the amount of saturation. Sounds most interesting in combination with the Drive parameter.
Gate: Sets the threshold value for the gating effect. This gating effect can be steered via a side-chain input.
Mix: Lets you determine how much you want to hear of the effect signal. 100 % means pure effect, 0% 
means pure band signal. 
Output: Sets the output level of each frequency band.

Side-Chain: Shows/Hides the side-chain section

On / Off: Activates/Deactivates side-chaining per band
Source: Lets you choose the source for the side-chain signal.

Internal: the input signal of the track is used.
Side-Chain 1 to 3, you can choose from 3 different tracks.

Listen: Lets you monitor the side-chain signal and the applied filter.
Freq: Sets the frequency value for the side-chain filter
Q: Sets the Q-value for the side-chain filter.
Send To: Lets you route the side-chain signal to the compressor section (Squasher) or the gate.
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Multiband Imager Plug-in
This plug-in allows you to expand or reduce the stereo width of your audio in up to four bands. This way you can 
independently adjust the stereo image in defined frequency domains. Each band is visualised with a dedicated Phase 
Scope and Correlation display.

Use the top display to adjust the split point for the bands and the handle for each band for controlling the Output level.

Available Parameters:

Number of Bands: Allows you to add and remove bands.
Live: Reduces the internal plug-in latency for real-time input operation using an optimised filter bank
Band On/Off: Activates/Deactivates the corresponding section.
Soloing Frequency Bands: To solo a frequency band, activate the S button in each section. Only one band 
can be soloed at a time
Width: Allows you to control the stereo width per band.
Pan: Allows you to pan the signal left/right. 
Output: Sets the output level for each band.
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Frequency 2 - Dynamic EQ Mode
The Frequency EQ plug-in now allows you, to set bands 1-8 individually into a "Dynamic" mode: If activated, filtering 

addition nowfor these bands is then depending on the dynamics of the input signal. In   there is   a View mode available 
generouswhich shows only controls for a selected EQ band with the full set of available parameters in a more   layout.

The Dynamic mode is available for these filter types:

Low Shelf
Peak
High Shelf

Available Parameters:

DYN: Activates/Deactivates dynamic filtering. Only one of these options 'Linear Phase' and 'Dynamic' can be 
activated at the same time.
Show Dynamics Parameters: Click on the little triangle left to the   button to show/hide the dynamic DYN
parameters. 
Start: This is the starting point for the gain, when the input signal is below the threshold.
THRESH (-50 to 0 dB): Determines the threshold level. Only signal levels above the threshold are processed.
ATTACK (0.1 to 100 ms): Determines how fast the dynamic EQ responds to signals above the threshold. If 
the attack time is long, more of the early part of the signal passes through unprocessed.
RELEASE (10 to 1000 ms): Sets the time after which the dynamic EQ returns to its original level when the 
signal drops below the threshold.
Ratio: The higher the level of the input signal is above the threshold, the more filtering occurs. Low ratio 
values mean that the filter starts to boost or attenuate smoothly above the threshold. High ratio values mean 
that the filter starts to work almost immediately.

This plug-in now supports multiple Side-Chain inputs (up to 8), check the Single View Mode > Side-Chain are.
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Supervision Metering Plug-in
SuperVision is a professional tool suite for monitoring and analyzing your audio. The plug-in comes with several 
different modules for level, spectral, phase, or waveform analysis. It allows you to create custom layouts with up to 9 
module slots.

Each module has its own setup of several customisable options
SuperVision features two different processing modes:

Sample Accurate and Maximum Performance
You can choose which mode to use for each module independently

The user interface is fully resizeable

Available Modules

Level: This module shows the level of your audio. It provides a multi-channel true peak meter and a 
maximum level value display.

: Loudness This module shows the loudness of your audio in units of LU (Loudness Units) or LUFS 
(Loudness Units, referenced to Full Scale) according to EBU R 128.

 : Spectrum Curve This module uses FFT (Fast Fourier Transform) techniques to display a frequency graph, 
providing a precise and detailed real-time frequency analysis.

 : Spectrum Bar This module shows a graphical representation of the frequency spectrum, analyzed into 
separate frequency bands, represented as vertical bars.

 : Spectrum Intensity This module represents the frequency magnitude of the audio. The more intensely a 
bar is colored, the higher the magnitude at this frequency.

: This module shows the last seconds of the audio stream. This allows you to detect Spectrogram
disturbances in the spectrogram and to monitor the noise level and frequencies, for example.

: Chromagram This module displays a chromagram of your audio.

: Phasescope This module uses a vectorscope display to show the phase and amplitude relationship 
between the left and right stereo channels. This provides you with directional information about a stereo 
audio signal. 

: Panorama This module uses a polar coordinate display to show the phase and amplitude relationship 
between the left and right stereo channels. This provides you with directional information about a stereo 
audio signal.

: Correlation This module visualizes the phase-correlation between the left and right channel. This allows 
you, for example, to check the mono compatibility of a stereo recording.

: Multicorrelation This module visualizes the phase-correlation between the left and right channel for 
different frequency bands.

: Surround This module visualizes the level and correlation of the different speakers in a surround speaker 
setup.
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: This module allows you to visualize the energy distribution of an Ambisonics signal.Ambisonics

Oscilloscope: This module shows a highly magnified view of the waveform.
Wavescope: This module displays the real-time waveform of the audio signal.
Wavecircle: This module displays the real-time waveform of the audio signal as a circle.

: Time This module shows a time display.
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Side-Chain with support for multiple Inputs
It is possible now to create Side-Chain connections coming from multiple sources, resp. inputs into one plug-in:

The number of possible Side-Chain inputs depends on the plug-ins - which have to support this functionality 
also from their side
In the Side-Chain Routing pop-up select the desired input

Inputs already connected to tracks are marked in the list
Then click "Add Side-Chain Source" to finish the setup and adjust the plug-in as needed

The following plug-ins support multiple Inputs:

Squasher: Up to three inputs, so every band can be controlled by up to three different side-chain sources
Frequency 2: Up to 8 inputs, one for each EQ band, see Side-Chain parameters of a desired EQ band when 
in single View mode
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Revised ARA 2.0 Support
In Cubase 10.5 a bounce of the audio event is necessary before Cubase can commit the selected event to the ARA 
extension, e.g. Melodyne/Spectralyers.

Bouncing the selected audio event to a new audio file/event has a lot disadvantages and can break some common 
workflows.
In Cubase 11 we cheanged this behaiour. So a bounce is no longer involved when committing an audio event to the 
selected ARA extension.

Advantages

Event Fades are preserved and can still be edited 
Event Volume Envelope will be preserved and can still be edited 
Pre-Record buffer will be preserved
No new audio file will be created when using an ARA extension on an audio event

For audio events, committed to an ARA extension, the following realtime and offline edit options are not editable via 
info line, the Sample Editor or Direct Offline processing:

Info Line

Musical mode on/off
Invert Phase on/off
Transpose
Fine Tune
Pitch/Timestretch Algo

Sample Editor

Musical Mode on/off
Hitpoints
Vari Audio
Audio Quantization

All Offline Processes are applied to the event before the event will handed over to an ARA extension.

Note: All those edits/settings/processes are preserved with the ARA extension and will be restored and become 
editable again if the ARA extension will be removed from the audio event.

Faster Workflow: Temporarily making the ARA extension the default Audio Editor

Two new toggle modes allow you to accelerate your worflow with your ARA extension. Especially, when you need to 
edit multiple audio events with the assigned ARA extension. The two toggle modes are called "Add Events" and 
"Remove Events" and can be found in the Toolbar of the ARA extension editor.

Add Events: If you activate "Add Events" each event which you select in your project will be added to the ARA 
extension and can be edited in the ARA editor immediately. This allows you a kind of native editor workflow with your 
ARA extension inside Cubase/Nuendo. Please remember to deactivate the mode if it's no longer needed, in order to 
avoid unwanted assignment of events.

Remove Events: The "Remove Events" toggle mode allows you to do the opposite. So in this mode, you can un-
assign selected events from the ARA extension. This will accelerate your worflow with your favourite ARA extension 
inside Cubase/Nuendo.
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Win 10: Variable DPI Support
With the Cubase 10.0.x generation we introduced support for HiDPI/Retina resp. 4K/UHD displays. This version 
provided the essential possibility to draw a scaled user interface with sharp and precise UI elements. That version 
was able to adapt to the scaling factors set up in Windows itself. The support for this was quite basic though, as we 
could only adapt to either 100% or 200%.

In the meantime HiDPI-capable displays have emerged more and more and specific types of displays have become 
common now, which Windows recommends to be used with a scaling factor of e.g. 150%. This meant to use Cubase 
in 200% (HiDPI enabled) or with 100% (HiDPI disabled).

With Cubase 11, the application is now able to work with additional scaling settings, such as 125%, 150% 
and 175%. 

Please note that we do not support other scaling settings specifically (e.g. 133%).
HiDPI must be enabled (it is enabled by default)
In case preferences from previous versions have been migrated, please make sure that in Preferences > 
General > "Enable HiDPI" is checked!

You should immediately see an improvement, especially when you want to work with a scaling setting of 150%.



Cubase 11 Beta Documentation Page 47 of 56 Steinberg Media Technologies GmbH

 

macOS: Modernized Graphic Back-end
The application now uses a modernized graphic back-end utilising the latest technologies available on macOS and 
supported systems. It is responsible for drawing all the user interface elements and event data.

The application is supposed to visually appear as before without differences.

Anyway, please keep an eye on visual glitches or inconsistencies you may notice while working.
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Various Other Improvements (C11)

Options for showing Marker Events

Its now possible to control whether Marker Events are drawn across the whole Project window. If enabled, a thin line 
with the same color as the Marker Events is drawn across the whole vertical area of the Project window.

By default, Marker Events of the currently active Marker Track use the extended drawing.

The following options can be used when opening the context menu on a Marker Track > Draw Marker Lines
(or in Preferences > Event Display > Markers):

None: Marker Events are drawn only within their track height, as in previous versions
Active Marker Track: Only these Marker Events are extended across the Project window
All Marker Tracks: Marker Events from all Marker Tracks are extended across the Project window

When using Marker Tracks as Global Tracks in the Editor, the same options apply but additionally its also 
dependent which Markers Tracks you enable there to be shown
Markers which are hidden by Track Visibility also won't show their extended drawing in the Project Window

Focus Indication when using "Divided Track List"

Similar to the focus indication used for the Global Tracks area in the Key Editor, the same visualisation is used 
when using the Divided Track List feature:

The editor area which has the current focus is indicated by the usual white and solid focus frame, the non-active area 
is drawn with a dashed pattern for visual separation.

PolyPressure Lane Handling Improvements

When working with PolyPressure Lanes in the MIDI Editors the following improvements have been made:

Selecting a note will switch the Lane to the corresponding note pitch automatically
When working with multiple PolyPressure Lanes, to top most one will continue to switch according to Note 
selection, the others will stay as set up
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Use the drop-down menu underneath the PolyPressure Lane label to select the note for which you want to 
see/edit PolyPressure data for a specific Lane

Delete Notes with double-click / how to access the Note Expression Editor

Some versions ago we simplified the creation of notes in the Editor by just double-clicking into the Editor. Since that 
the desire to allow to delete them the same way came up prominently.

It is now the default behaviour that double-clicking a note will delete it!
If you are an Note Expression user you can now decide whether a double-click will delete a note or if the 
Note Expression Editor is opened instead (as in previous versions)

To do so, make sure the " " item is visible in the Toolbar, then enable the "Show Note Expression Do
" buttonuble-click opens Note Expression Editor

 
This option is handled as an application preference, which means it is a global setting and 
remembered as set - independently from your projects
You can assign a key command to toggle the behaviour as needed, see Edit > Key Commands... > 
Note Expression > Double-click opens Note Expression Editor On/Off
We also added an entry in , also a key MIDI > Note Expression > Open Note Expression Editor
command can be assigned to this

The Note Expression Editor can be also opened  when using the context menu directly on 
top of a note event

 

Combined Select Tool mode: Range-selected events after "Split" selects them as 
Objects

When using the "Combined Select Tool" mode and you create a Range Selection followed by the Edit > Range > Split 
(Shift+X) command the newly created events are immediately selected for further actions, such like mute, move, etc.

Show Version with Track Name

When using Track Versions the addition of the Track Version name to the Track Name can get messy. You can now 
select, whether Track Version names should be shown or not. 
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The option can be found within the Track Version menu to the right of each Track Name field.

MixConsole Window - Improved Open/Close Behaviour

When attempting to open the MixConsole window (via key command "F3") you may have noticed, that it sometimes 
needs two key strokes. This was due to the fact, that the window may have been already open but was covered by 
other windows in the foreground. Thus, key stroke #1 closed the window first and key stroke #2 was necessary to 
open the window to the foreground.

We have changed this - so opening and closing the MixConsole window is now always exactly one key stroke away.

Logical Editor Extensions

The following extensions have been made to the Logical Editor:

New Context Variables: "Highest in Chord from at least n Notes" / "Lowest in Chord from at 
least n Notes"

This allows you to operate on notes within chords, e.g. extract each highest or lowest note over a progression of 
chords. As an example, see the following MIDI Part:

To select highest each   note, open the Logical Editor and set it up like this:
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Type Is - Equal - Note AND
Context Variable - Bigger or Equal  - Highest in Chord from at least n Notes - 2
Function: Select

When you apply this, G#3, A4, F4, E4 will be selected in the MIDI Part. The same can be done for the lowest note, 
extractusing "Lowest Note in Chord..." for Parameter 1. You can e.g.   notes to create a bass line from it. Please note 

the Parameter 2 with the value of 2, this means that there have to be at least 2 notes in order to determine the high or 
example.low ones in this 

Test Generator plug-in Update

This plug-in has been updated with a new look and high-resolution graphics.

Mixer Delay plug-in Update

This plug-in has been updated with a new look and high-resolution graphics.
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New Detail View for Maximizer Module in Channel Strip - Channel settings Window

The Maximizer Module offers now a Detail view for in the Channel Settings Window.

The Detail view gives you access to additional and advanced Parameters:

Modern Mode: 
In   mode, the algorithm allows for more loudness than in   mode. This mode is particularly Modern Classic
suited for contemporary styles of music.

Modern mode also provides additional settings to control the release phase:

Release sets the overall release time.
Recover allows for a faster signal recovering at the beginning of the release phase.

Soft Clip: If this button is activated, Maximizer starts limiting or clipping the signal softly. At the same time, 
harmonics are generated, adding a warm, tube-like characteristic to the audio material.
High Resolution Input/output Metering incl. value readout and Gain Reduction. 

Default setting for New Projects location changed to "Prompt for Project Location"

Cubase 11 will ship with "Prompt for Project Location" now instead of the previous setting "Use Default Location".
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New MIDI Remote System & API

Introduction

Starting with Cubase 11 we will offer a complete new way how 3rd party MIDI Remote Controllers can be integrated 
and utilised with the application.

Up to now, most of these devices could be only used by setting up features such as Track- or VST-Quick Controls and
/or Generic Remote. The discoverability of these features and complexity of the steps to set up them is not suitable 
anymore, especially not for novice users. In some cases devices are supported by the Mackie Protocol, but this still 
requires some amount of knowledge of the application and the interaction with the device itself.

All mentioned features in this area will remain for compatibility reasons for the time being. But we want to encourage 
hardware manufacturer to create dedicated scripts, aka device drivers to make their devices and capabilities known to 
Cubase using the new system. It will finally end up in a "Plug & Play" experience for end-users with essential zero 
configuration effort.

MIDI Remote API

We have created a MIDI Remote API which allows to develop MIDI Remote Scripts for dedicated devices. In a 
nutshell, these scripts describe the layout and order of controls the device has to offer and include factory mappings 
to parameters in Cubase. 

With Beta 1 of Cubase 11 the new MIDI Remote system is now part of the application and allows 3rd party MIDI 
Remote Device manufacturers to create support for their products in Cubase 11 and onwards. Our main intention 
here is, to get you on-board in having a look at the API and by creating scripts for your specific devices of choice.

Please note: The API itself is in Alpha 2 state! Details may still   and can influence already written change
scripts.

Where to find the "MIDI Remote API - Programmer's Guide"

After installing Cubase 11 you need to start it once. Now locate the following folder on the system:

Windows 10: \Users\<username>\AppData\Roaming\Steinberg\Cubase 11_64\Scripts\MidiRemote
macOS: /Users/<username>/Library/Preferences/Cubase 11/Scripts/MidiRemote/

Open the " " file there to open the . It will explain the concept and contains README_v1_0.html Programmer's Guide
example code and the API reference.

The "MIDI Remote" tab in Cubase 11

In Cubase itself, devices with a script can be shown in the Lower Zone > Remote tab. In case it is not visible, right-
click on the existing tabs and enable it from there:

In the following picture you see an example of how Cubase derives a visual representation from a MIDI Remote Script:



Cubase 11 Beta Documentation Page 54 of 56 Steinberg Media Technologies GmbH

The representation serves the following purposes:

Show a similar layout of controls on-screen with a strong resemblance to the physical device
Show the mappings of the various controls to parameters within Cubase
This way users will be able to look up which hardware control to use for adjusting the desired parameters in 
Cubase - a visual reference which also follows the track selection accordingly

Without any dedicated scripts, you can get a first impression by checking the three "MIDI Device" examples from the 
toolbar.

The "ExampleCompany - RealWorldDevice" also shows an additional aspect of having "Pages":
Devices can used to provide controls for multiple amounts of channels at the same time ("Mixer")
The same devices can be set to another page, to work in a "Selected Track" context, thus providing 
the possibility to control more parameters belong to one specific track
Additionally another page is available to control parameters "2 Selected Tracks"

Please note: This visual representation is not meant to control Cubase from there. Thus it is not a clickable user 
interface - the operation is meant to be done with the physical device itself.

Beta 1 - Current Development Status

For end users without having devices supported by a script there is not much to see and use so far. This 
version is aimed mainly for API evaluation and script development
Further details will follow in subsequent beta releases, e.g. in regards to parameter mappings:

Scripts will have Factory Mappings, which can be organised in different types of Pages by the 
manufacturer
Users will be able to adapt Factory Mappings to customise them as new "Global Mappings" across 
different projects
Users will be able to adapt Mappings specifically to their needs in specific projects

We are working on a way to easily click parameters in Cubase to "Learn" them to a hardware control
We are working on a way to get some basic and generic template scripts ready for devices not yet supported 
by a script
We are working on a way to setup a device with a script but the auto-detection could not recognise it (e.g. 
device is connected via old-style MIDI interface ports and not via USB to the computer)
We are working on a way on how to deploy scripts independent from actual Cubase 11 releases

Hint for not losing scripts accidentally!

In the moment scripts are placed within the application preferences folder - this is meant to change for the 
final release though!
In case you delete the preferences folder (e.g. due to trouble-shooting) be sure to save the scripts from there 
somewhere else first!
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Discontinued Features

Audio Connections - Removed automatic Input/Output presets

The Preset menu will now be no longer peppered with an automatic creation of various Input or Output port 
configurations, except for two simple mono/stereo port configurations. This leaves room for your own and useful 
presets, especially when using audio hardware with large amounts of available ports.

Audio Export removed in WMA format 

The application no longer supports audio exports using the WMA format. Import of WMA files will remain though.

Wave64 format removed

The application no longer supports the "Wave64" format as Record File Format or for exporting audio. Import of this 
format will remain though. The common wave/broadcast format can be used instead.

OpenTL Import/Export removed

This affects Nuendo 11 only. It is no longer possible to import or export files in this legacy format.
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